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SUMMARY: 38 

Digital annotation with automated tissue dissection provides an innovative approach to enriching 39 

tumor in low tumor content cases and is adaptable to both paraffin and frozen tissue types. The 40 

described workflow improves accuracy, reproducibility and throughput and could be applied to 41 

both research and clinical settings. 42 

 43 
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Tumor enrichment in low tumor content tissues, those below 20% tumor content depending on 45 

the method, is required to generate quality data reproducibly with many downstream assays 46 

such as next generation sequencing. Automated tissue dissection is a new methodology that 47 

automates and improves tumor enrichment in these common, low tumor content tissues by 48 

decreasing the user-dependent imprecision of traditional macro-dissection and time, cost, and 49 

expertise limitations of laser capture microdissection by using digital image annotation overlay 50 

onto unstained slides. Here, digital hematoxylin and eosin (H&E) annotations are used to target 51 

small tumor areas using a blade that is 250 μm2 in diameter in unstained formalin fixed paraffin 52 

embedded (FFPE) or fresh frozen sections up to 20 μm in thickness for automated tumor 53 

enrichment prior to nucleic acid extraction and whole exome sequencing (WES). Automated 54 

dissection can harvest annotated regions in low tumor content tissues from single or multiple 55 

sections for nucleic acid extraction. It also allows for capture of extensive pre- and post-harvest 56 

collection metrics while improving accuracy, reproducibility, and increasing throughput with 57 

utilization of fewer slides. The described protocol enables digital annotation with automated 58 

dissection on animal and/or human FFPE or fresh frozen tissues with low tumor content and 59 

could also be used for any region of interest enrichment to boost adequacy for downstream 60 

sequencing applications in clinical or research workflows. 61 

 62 

INTRODUCTION: 63 

Next generation sequencing (NGS) is increasingly utilized for both patient care and in cancer 64 

research to help guide treatments and facilitate scientific discovery. Tissue is often limited and 65 

small specimens with variable tumor content are routinely used. Tumor adequacy and integrity, 66 

therefore, remain a barrier to obtaining meaningful data. Samples with lower tumor percentages 67 

may cause difficulty in distinguishing true variants from sequencing artifacts and are often 68 

ineligible for NGS1. Tumor enrichment of low tumor content cases, those below 20%, has been 69 

shown to help yield sufficient material in order to generate reproducible sequencing data and 70 

ensure low frequency variants are not missed2,3. However, limits will vary depending on the 71 

platforms utilized and planned use of the data generated. 72 

 73 

Traditionally, enrichment of tumor regions for extraction is performed by manual 74 

macrodissection or laser capture microdissection (LCM) of formalin fixed paraffin embedded 75 

(FFPE) slides. Manual macrodissection, or scraping specified tissue areas from slides, allows 76 

tumor regions to be removed for use in downstream assays with relatively low cost, but with low 77 

accuracy and low precision2,4. Minimal technical accuracy can be very effective with higher tumor 78 

content cases where large swaths of tumor are present and/or minimal tissue loss does not 79 

significantly impact results, but low tumor content cases or cases with more dispersed tumor 80 

require increased precision. LCM was therefore invented in the 1990s and became a valuable 81 

way to precisely remove small, defined, microscopic regions of tissue from formalin fixed paraffin 82 

embedded (FFPE) slides5–8. LCM can be utilized to collect single cell populations when complex 83 

heterogeneity of the sample exists9 allowing for collection of previously difficult to separate cell 84 

populations. However, LCM requires costly machinery that requires extensive technical expertise 85 

and hands-on time10–14. 86 

 87 
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The instrument used for automated tissue dissection has precision in between that of LCM (~10 88 

µm) and macrodissections (~1 mm)15. Additionally, it exhibits both cost and technical expertise 89 

requirements between that of macrodissection and LCM and is designed to perform rapid tissue 90 

enrichment from sequential FFPE slides to alleviate the disadvantages of previous methods15. 91 

Automated dissection in this fashion utilizes digital annotations or on-stage slide reference image 92 

overlays onto serially sectioned unstained tissue slides for dissecting and enriching regions of 93 

interest. The instrument uses plastic spinning blade milling tips, 1.5 mL collection tubes and can 94 

be used with a number of different fluids for dissection to collect regions of interest for 95 

downstream assays inclusive of nucleic extraction and sequencing. The spinning plastic milling 96 

tip utilizes inner and outer syringe barrel reservoirs and a plunger to collect buffer, then mills and 97 

collects tissue16. The variable milling tip size diameter (250 μm, 525 μm, 725 μm) can allow for 98 

dissection of separate tissue areas for comparison, multifocal regions that can be pooled or 99 

individual small areas from single or multiple FFPE slides. Section thicknesses used for harvest 100 

can be adjusted based on individual experiment needs and users can ensure regions of interest 101 

have not been depleted by performing an additional H&E on one serial section immediately after 102 

the last section used for harvest. 103 

 104 

Automated dissection was identified as a way to enrich tumor content in low tumor content cases 105 

and tested and expanded the intended functionality of an automated tissue dissection 106 

instrument, which is currently marketed for use on FFPE clinical specimens up to 10 μm in 107 

thickness. The work shows that automated dissection can be applied to both FFPE and fresh 108 

frozen human or animal tissue sections up to 20 μm in thickness for research purposes. The 109 

protocol also demonstrates an approach to digitally annotate and automate dissection for tumor 110 

enrichment in tissues with low tumor content and/or cases with nested, dispersed tumor where 111 

meaningful macrodissection is challenging or not feasible and show both quality and yield of 112 

nucleic acid sufficient for NGS. Automated dissection can therefore provide mid-level precision 113 

and increased throughput for tumor enrichment and could also be applied to enrich other regions 114 

of interest or combined with other platforms to answer research or clinical questions. 115 

 116 

PROTOCOL: 117 

 118 

Prior to initiation, obtain appropriate tissue specimens according to Institutional Review Board 119 

(IRB) protocols. All methods described here have been approved by the Institutional Animal Care 120 

and Use Committee (IACUC) of Genentech, Inc. 121 

 122 

1. Tissue and slide preparation 123 

 124 

1.1. Select FFPE or fresh frozen tissue blocks and utilize the corresponding processing method 125 

below. 126 

 127 

1.2. Cut tissue block sections onto positively charged glass slides at the desired thickness. 128 

Serially section the FFPE tissue in ribbons with the first reference section cut at a thickness 129 

appropriate for H&E staining (i.e., 4 μm) followed by 1–4 sections at a thickness ranging from 4–130 
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20 μm based on the need and tissue availability. Collect the tissue sections onto positively 131 

charged glass microscope slides. 132 

 133 

NOTE: Fresh frozen reference tissue sections should be stained immediately with Hematoxylin 134 

and Eosin (H&E) using routine protocols for frozen sections and the unstained frozen sections 135 

held at -20 °C until they are needed for harvest. 136 

 137 

1.3. Allow all the FFPE sections to dry at room temperature overnight. 138 

 139 

1.4. Bake the FFPE reference slides at 60 °C for 30 min and then stain with H&E using routine 140 

protocols. 141 

 142 

1.5. Scan the H&E stained slides on a whole slide imager at 20x magnification or greater. 143 

 144 

1.6. Annotate the scanned slide images for tumor regions of interest using a vendor provided 145 

viewing platform or open-source viewer. Export these annotations as either a low-magnification 146 

screenshot or save them as a metadata file containing X-Y pixel coordinates corresponding to 147 

polygon vertices. 148 

 149 

NOTE: The former is less technically challenging to work with, but the latter offers advantages in 150 

process automation. 151 

 152 

1.7. Create digital masks of the annotated regions of interest in line with the approach used 153 

and export the manual annotations. 154 

 155 

NOTE: If a screenshot/image of the annotations is used, simple image processing software can 156 

be used to select a region and to fill in the entire selection. Using X-Y coordinates for each ROI 157 

requires the use of a programming language to read both the image data and polygon 158 

coordinates to create a low-mag image with filled in regions of interest. The user should work 159 

with the automated dissection instrument vendor to establish a process based on their individual 160 

software availability and needs. If scanning, digital slide annotation and/or digital mask creation 161 

is unavailable, careful on-slide annotation using a marker can be performed and used in place of 162 

a digital mask as a reference image. Pseudocode for digital mask creation has been provided in 163 

Supplementary File 1. 164 

 165 

2. Automated tissue dissection 166 

 167 

2.1. Place the unstained sample tissue slides onto the stage in the first through fourth slide 168 

positions when using digital slide reference. When using on-slide annotation rather than a digital 169 

option, place the unstained sample tissue slides onto the stage in the second through fourth slide 170 

positions with a reference slide in the first position. 171 

 172 

2.2. Create a milling job using the automated tissue dissection software: Job Selection > 173 

Create New Job > Case ID > Name the milling job; go to Thickness > Section Thickness using the 174 



 

up or down arrow tab; then go to Tissue Preparation > Paraffinized or Deparaffinized, Reference 175 

Image > From File > Import Image > File to import from the dropdown as the digital reference, if 176 

applicable. Select From Stage for on stage slide reference. When fields are complete, scan the 177 

stage by selecting the Scan Stage button in the bottom-right corner to capture each sample tissue 178 

slide in the first through fourth position. 179 

 180 

2.3. Select the tissue area for image capture. 181 

 182 

2.3.1. If using an on-stage reference, drag the box from one corner to the opposite to create a 183 

rectangular area over tissue. Select the circular bubble under the rectangular area to capture the 184 

stage reference image. If using a digital reference image, overlay the image on the rectangular 185 

area selected. Resize and align the digital reference grossly in course zoom to best match the size 186 

and position over the sample tissue. 187 

 188 

2.3.2. Copy this rectangle field onto remaining sample tissue slides in the second through fourth 189 

slide positions by selecting the copy option in the upper-right corner of the reference image. 190 

Align and resize grossly as necessary. 191 

 192 

NOTE: When using an on-slide reference image rather than a digital mask, select which slide on 193 

the stage should be used as the reference. 194 

 195 

2.4. Align the reference and sample slides 196 

 197 

2.4.1. When the reference image is grossly aligned on tissue sample slides in all slide positions, 198 

select the Scan Stage button in the lower-right corner of the screen to move into the fine 199 

adjustment step. Select the first stage position and Transform tool icon (the third icon down in 200 

the right-hand toolbar) to make fine alignment and zoom adjustments of the reference to best 201 

match the sample slide overlay. Use the Reference to Sample sliding bar at the bottom of the 202 

screen toggling between reference image and sample image along with the Zoom In and Zoom 203 

Out feature to adjust and achieve alignment of each slide position. Replicate this process in the 204 

second through fourth sample slide positions. 205 

 206 

2.5. Select the milling area of region of interest 207 

 208 

2.5.1. Once optimal sample overlay of each of the four slide positions is achieved, draw milling 209 

path designations using the Color Picker tool icon (the tenth icon down in the right-hand toolbar) 210 

on the colored portion of masked reference image. Select the Get Annotation(s) button in lower 211 

right to draw milling paths onto sample slides. 212 

 213 

2.5.2. Select the milling path in the first slide position. 214 

 215 

NOTE: When the milling path is selected in the first slide position, it will be copied onto the 216 

remaining slide positions and milling tip usage will be calculated. The milling tip usage in the 217 

upper-left corner is calculated based on the area covered and the tip size selected. If more than 218 



 

four tips are calculated, a larger tip size can be selected to capture the annotated ROI. Tip size 219 

can be selected or changed on the left side of the screen under the Milling Tip arrow and tip 220 

usage will be recalculated. 221 

 222 

2.5.3. When the milling path is calculated, collect the annotated ROI with four or less milling 223 

tips. Select the Setup Stage button in the lower right of the screen to prompt loading of milling 224 

tips from placed collection tubes in their proper designation on stage. 225 

 226 

2.6. Fill the reservoir with 3.0 mL of the dissection buffer most appropriate for the tissue type 227 

(FFPE or fresh frozen) and downstream nucleic acid extraction kit needs and select the Dissect 228 

button in the lower-right corner of the screen. Use molecular grade mineral oil or an appropriate 229 

buffer from commercially available nucleic acid extraction kits. 230 

 231 

NOTE: Automated dissection of slides and selected regions of interest then begins and samples 232 

are collected by the instrument. The unit head will pick up milling tips from the back of the stage 233 

and fill with dissection fluid from the reservoir. Tips then spin along the milling path aspirating 234 

sample tissue from slides until complete or full. The collected sample with dissection fluid is then 235 

dispensed into collection tubes located at the back of the stage. 236 

 237 

2.7. When automated dissection is complete, remove the collection tubes and the dissected 238 

sample slides from the stage and place them in a tube rack and slide rack, respectively. 239 

 240 

NOTE: Fresh frozen harvests should be taken directly into nucleic acid extraction as per the 241 

manufacturer's instructions and post-dissection fresh frozen sections should be H&E stained 242 

immediately using routine protocols for frozen sections. 243 

 244 

2.8. Bake the post dissected tissue slides at 60 °C for 30 min and then stain with H&E using 245 

routine protocols. 246 

 247 

2.9. Scan the post dissected H&E stained slides on a whole slide imager at 20x magnification 248 

and/or archive for a reference of what tissue was not collected and remains on the slide. 249 

 250 

NOTE: See step 1.5 above for alternative scanning options. 251 

 252 

3. Nucleic acid extraction 253 

 254 

3.1. Pool and pellet the tissue. Perform the nucleic acid extraction using a commercially 255 

available kit and following the manufacturer’s instructions. 256 

 257 

REPRESENTATIVE RESULTS: 258 

FFPE and FF mouse liver sections containing metastatic colorectal cancer in xenografts were 259 

selected. Sections were H&E stained (Figure 1A,E,I) and scanned on a whole slide imager at 20x 260 

magnification. A pathologist digitally annotated tumor regions of interest and a mask was 261 

generated using commercial software and formatted as a digital png reference image (Figure 1B, 262 



 

F,J). Serial 10 μm and 20 μm thick unstained sample slides were placed on the stage and 263 

automated dissection was performed as described above. Fresh frozen tissues were collected in 264 

a lysis buffer from a commercially available kit and carried directly into nucleic acid extraction 265 

following the manufacturer’s instructions. FFPE samples were collected using molecular grade 266 

mineral oil and dissected samples were pooled together and centrifuged at 25,000 x g for 20 min 267 

at 4 °C. The supernatant was removed and the minimal mineral oil required was used to 268 

resuspend, transfer, and collect the dissected tissue into a single collection tube for each sample 269 

appropriately. Samples were shipped at room temperature to a vendor for nucleic acid 270 

extraction, RNA and DNA sizing, quantity, integrity, and purity determination following the 271 

manufacturer's instructions. Sequencing libraries were created and used for hybridization and 272 

capture with commercial options following the manufacturer's instructions. Post dissected 273 

sample slides were H&E stained using routine staining protocols to confirm dissection areas in 10 274 

μm (Figure 1C,G,K) and 20 μm (Figure 1D,H,L) slides and dissection metrics were captured 275 

(Supplementary Table 1). Exome sequencing generated approximately 75 million 100 bp paired-276 

end reads, yielding an average depth of coverage (before removing duplicate reads) of 150x per 277 

sample, with 99.9% reads aligned and a 78% on-target rate. RNA sequencing metrics 278 

demonstrated just over 55 million bp paired-end reads, a 98% alignment rate, and a 19.4% 279 

duplication rate with 77% concordant reads. 280 

 281 

FIGURE AND TABLE LEGENDS: 282 

 283 

Figure 1; Successful dissection of tumor nests from fresh frozen and FFPE tissue. H&E stained 284 

mouse fresh frozen (A–D) and FFPE (E–L) liver tissue with colorectal cancer metastasis. 4 μm 285 

reference slides used for digital annotation (A, E, I) demonstrate examples with a low tumor 286 

percent for the total tissue area (I) and distributed tumor nests (E) that classically present 287 

challenges to tumor enrichment. Annotated and digitally masked H&E reference slides (B, F, J) 288 

were generated and post-dissection 10 μm (C, G, K) and 20 μm (D, H, L) H&E stained slides 289 

demonstrate successful harvest of selected areas. 290 

 291 

Supplementary File 1: Pseudocode utilized to create digital masks from annotations to use in 292 

automated dissection. 293 

 294 

Supplementary Table 1: Example captured metrics from automated dissection and nucleic acid 295 

extraction. 296 

 297 

DISCUSSION: 298 

Presented here is a protocol for the application of digital annotation and automated dissection 299 

to dissect tumor regions from low tumor content FFPE or fresh frozen tissues for tumor 300 

enrichment and use in WES. Combining digital annotation and mask creation with automated 301 

dissection significantly reduces the required hands-on time and expertise common to classical 302 

methods of tumor enrichment inclusive of manual macrodissection and LCM. The protocol 303 

demonstrates a potentially important mid-range tumor enrichment option that allows for not 304 

only low tumor content enrichment but also enrichment in cases where it is challenging to dissect 305 

distributed tumor nests away from the tumor adjacent normal tissue for meaningful tumor 306 



 

enrichment with high throughput and a moderate level of precision. While the use of our 307 

workflow for low tumor content xenograft tissues is demonstrated here, it was also found that 308 

this protocol works across tissue types, including human, murine, and xenograft tissues for a 309 

variety of normal tissues and cancer indications. 310 

 311 

Therefore, it could also apply to a broad range of applications where enriching for specific regions 312 

of interest without significant contamination of background tissue would be beneficial (i.e., to 313 

enrich for a specific brain region) or even for removal of areas of tissue prior to nucleic acid 314 

extraction using classical macrodissection. 315 

 316 

Many platforms exist on the market for slide scanning and digital annotation. It is therefore 317 

important to remain aware that platform compatibility may present limitations and specified 318 

platforms within any protocol may not be broadly available in all laboratories. Therefore, 319 

significant efforts were made to provide alternative options within the described protocol that 320 

will guide users in making any necessary modifications based on their available resources. An 321 

option for removal of the digital annotation component have also been noted to allow for careful 322 

manual on-slide annotation. The options provided for modifications will maximize the ability of 323 

users to find an option that works with their current platform and software availability. 324 

 325 

While digital annotation and automated dissection have been demonstrated to be broadly 326 

applied to both FFPE and fresh frozen tissue, it is important to note that the boundaries of the 327 

automated tissue dissection instrument have been pushed beyond its intended use with FFPE 328 

specimens and the protocol is meant for research use only. Here, successful tumor enrichment 329 

was demonstrated through automated tumor dissection of low tumor content FFPE as well as 330 

fresh frozen tissues for nucleic acid extraction, WES and RNA sequencing. The protocol shows 331 

that xenograft and human tissue regions of interest could be enriched prior to WES and RNA 332 

sequencing in basic and translational research settings and also note that other downstream 333 

molecular applications, including PCR, from both tissue types would be possible. The protocol 334 

expands FFPE automated dissection options and lays the groundwork for fresh frozen tissue 335 

automated dissection that could be developed and validated further for use in clinical settings. 336 

 337 
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Name of Material/ Equipment Company Catalog Number Comments/Description
Agilent SureSelectXT Agilent G9611A
AVENIO Millisect Fill Station Roche 8106533001
AVENIO Millisect Instrument, Base Roche 8106568001
AVENIO Millisect Instrument, Head Roche 8106550001
AVENIO Millisect Milling Tips Small  Roche 8106509001
AVENIO Millisect PC Roche 8106495001
BioAnalyzer Agilent G2939BA
Eppendorf 5427R Eppendorf 22620700 Micro-centrifuge 
Incubation Buffer Promega D920D
Leica Autostainer XL Leica ST5010 Automated stainer 
Molecular Grade Mineral Oil Sigma M5904-500ML
Proteinase K Promega V302B Digestion buffer
Qiagen AllPrep DNA/RNA Mini Kit Qiagen 80284
RLT Plus buffer Qiagen 80204
Superfrost Plus positively charged microscope slides Thermo Scientific 6776214

Table of Materials Click here to access/download;Table of Materials;Automated dissection
JoVE_Materials.xlsx
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February 24, 2020 

 

Lyndsay Troyer, Ph.D 

Science Editor 
JoVE 

 

Dear Dr. Troyer, 

 

Subject: submission of revised manuscript JoVE62394 titled Automated Tissue Dissection 

Protocol for Tumor Enrichment in Low Tumor Content Tissues 

 

Response to Reviewers 

 

Thank you for your email from February 8, 2021 enclosing reviewer comments and for giving us 

the opportunity to submit a revised draft of our manuscript “Automated Tissue Dissection 

Protocol for Tumor Enrichment in Low Tumor Content Tissues” for publication in the Journal of 

Visualized Experiments. We appreciate the time and effort the reviewers dedicated to providing 

feedback and are appreciative of the insightful comments and valuable suggestions for 

improvement to our manuscript. We have carefully reviewed the comments and revised the 

manuscript accordingly.  Our responses are given in point by point manner below and also 

provided in tracked changes with all page numbers referring to the revised manuscript file 

containing the tracked changes.   

 

Sincerely, 

 

 

 

Amy A. Lo, MD, MS 

Scientist-Pathologist 
Research and Early Development 
Department of Pathology 
Genentech, Inc. 
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Point by point responses to reviewers: 

Editorial comments: 

1. Please take this opportunity to thoroughly proofread the manuscript to ensure that there are 

no spelling or grammar issues. 

 Author response: Thank you for the suggestion and the opportunity to to make these 

changes. We have carefully reviewed the manuscript to ensure spelling and grammar are 

correct with changes noted on lines 35, 37-38, 55, 64-64, 78, 109 and 155. 

 

2. Please rephrase the following sentences to avoid previously published work: Lines 63-66 

 Author response: We have modified lines 65-70 stating “it is widely accepted that 

specimens with <10 % tumor are not eligible for NGS because sequencing of samples with lower 

percentages may cause difficulty in detecting copy number variation and distinguishing true 

variants from sequencing artifacts1” to “Samples with lower tumor percentages may cause 

difficulty in distinguishing true variants from sequencing artifacts and are often ineligible for 

NGS.”  

 

3. For in-text citations, cite consecutive references (e.g., 10,11,12,13) as (e.g., 10-13). See lines 

78, 81, etc. 

Author response: Thank you for noticing this citation need, which has been corrected on 

lines 78 and 83 using a citation manager. 

 

4. Lines 105-107 should be included as a statement at the start of the protocol, and not as a 

step in the protocol. 

Author response: “Prior to initiation, obtain appropriate tissue specimens according to 

Institutional Review Board (IRB) protocols. All methods described here have been approved by 

the Institutional Animal Care and Use Committee (IACUC) of Genentech, Inc.” has been moved 

to the start of the protocol on lines 121-123 rather than being included as step 1.1. Numbering 

thereafter has been adjusted accordingly to accommodate this alteration. 

 

5. Line 141, 161: Please add more details to your protocol steps. Please ensure you answer the 

“how” question, i.e., how is the step performed? If button clicks/menu selections are identified 

(e.g., quotes or cursive text has been used), change them to bold text. Use either | or > between 

the clicks/selections, and do not use  or other symbols. Example: “File  Options  Advanced” 

becomes File > Options > Advanced or File | Options | Advanced 

Author response: Thank you for the suggestion. We have expanded details within the 

protocol and included button click/menu selections on lines 183-189 for step 2.2, line 210 for 

step 2.4.1, line 242 for step 2.6 and lines 250-255 for step 2.7. 

 

6. Use appropriate SI units. E.g. “60 oC” instead of “60C” (line 120, 122), “4 oC” instead of “4 C” 

(line 240), etc. Use “mL” instead of “ml” (e.g. line 216). Also include a single space between the 

quantity and its unit. E.g. “4 mm” instead of “4mm”. 



Author response: We appreciate you pointing this out and have made changes to correct 

the degree designations on lines 138, 142 and 264 and the mL designation on line 240 and 

ensured other quantities and units have a space, appropriately.  

 

7. Please avoid the use of personal pronouns in the protocol. E.g. “we”, our” etc. (e.g., line 248) 

Author response: Personal pronouns “we” and “our” have been removed from the 

protocol in lines 147 and 281. 

 

8. Line 220-221: Please clarify this sentence. 

Author response: We appreciate you pointing out the need for improved clarity and we 

have modified lines 254-264 for step 2.7 to better clarify both our sentence and the process for 

this step to ensure we are pointing out what the instrument will do as well as what is required 

from the user. Step 2.6 now includes a note about what to expect when automated dissection 

begins allowing step 2.7 to focus on the actions required after automated dissection is complete. 

Step 2.7 has been clarified to now read: “When automated dissection is complete, remove 

collection tubes and dissected sample slides from the stage and place them in a tube rack and 

slide rack respectively. Note: Fresh frozen harvests should be taken directly into nucleic acid 

extraction per the manufacturer's instructions and post-dissection fresh frozen sections should 

be H&E stained immediately using routine protocols for frozen sections.”  

 

9. JoVE cannot publish manuscripts containing commercial language. This includes trademark 

symbols (™), registered symbols (®), and company names before an instrument or reagent. 

Please remove all commercial language from your manuscript and use generic terms instead. 

All commercial products should be sufficiently referenced in the Table of Materials. E.g. 

AVENIO Millisect, Superfrost Plus, Leica Autostainer, NanoZoomer, Eppendorf, Qiagen AllPrep 

etc. 

Author response: Thank you for this suggestion. We have taken care to remove all of the 

commercial language and include commercial specifics in the Table of Materials. Specifically, 

we have changed “AVENIO Millisect” and “Millisect” to more generic phrasing (“automated 

tissue dissection instrument”) on lines 43, 87, 108, 183, 255, 342 and 398. We have also 

removed the commercial language for the slides on lines 132-133, mineral oil and lysis buffer on 

lines 243-244, slide scanner on lines 280-271, centrifuge on line 338, extraction and sequencing 

on lines 270-275 and 340-344, nucleic acid metrics on lines 325-326 and image analysis 

software on line 330.  

 

10. Please ensure that the references appear as the following: [Lastname, F.I., LastName, F.I., 

LastName, F.I. Article Title. Source. Volume (Issue), FirstPage – LastPage (YEAR).] For more 

than 6 authors, list only the first author then et al. Do not abbreviate the journal name. Please 

include volume and issue numbers for all references. 

Author response: We appreciate the opportunity to change our bibliography format and 

the references have been reformatted to that which is recommended using a citation manager 

(lines 424-462). 

 



11. Please revise the table of the essential supplies, reagents, and equipment. The table should 

include the name, company, and catalog number of all relevant materials in separate columns in 

an xls/xlsx file. Please sort the Materials Table alphabetically by the name of the material. 

Author response: The table has been updated, alphabetized and is submitted as an 

Excel file.  

 

____________________________________ 

Reviewers' comments: 

Reviewer #1: 

Manuscript Summary: 

1. I have been aware of the Millisect instrument since it came out and it's certainly a serious 

offering in the field and worthy of further published characterization. I have been keen to see 

results for tumour microdissection as it does appear to be efficient at extracting on the scale 

required for NGS library input. While it has considerably lower resolution than traditional LCM, 

extracting hundreds of nanograms of nucleic acids on conventional LCM is an exercise of 

remarkable tediousness. The description of the Millisect as falling in between LCM and manual 

dissection is therefore apt and frames the paper well. This manuscript does require a bit of 

reorganization though. As I understand it, as a JOVE publication should mostly be a method 

describing how to use an instrument or process in a general manner. This manuscript however 

also describes a particular experiment the authors performed, and this is mixed in with the 

general Millisect method in a manner that is confusing. For example there is discussion of FFPE 

extraction using Qiagen columns in section 3, but that's because that's what was done in the 

experiment. There are other methods for extraction of FFPE or OCT tissue that could be applied 

downstream of the Millisect so I would change step 3 to say "extract using Qiagen or Agencourt 

kits etc following manufacturers' directions".  

Author response: We would like to sincerely thank the reviewer for this feedback and 

agree that separating the experiment we performed and the general automated tissue 

dissection protocol would help add clarity for the reader and we have taken steps to generalize 

the protocol whenever possible. We have now used step 3 to instruct the user to pool and pellet 

tissue and perform nucleic acid extraction using a commercially available kit following the 

manufacturer instructions (lines 274-275) and included details on how our samples were 

processed in the representative results section (lines 335-344).   

 

2. Likewise the choice of scanner should be general so don't say to specifically use a 

NanoZoomer in step 2.9. In the discussion the authors actually state they are trying to make the 

method as general as possible, so decoupling from specific scanners and specific downstream 

chemistry is important. 

Author response: Thank you for the suggestion. We have modified this to ensure generic 

scanner terminology is utilized (lines 270-271). 

 

3. I suggest condensing the Millisect method to just the parts that are specific to preparing 

samples and running the instrument. Then go on to describe the specific experiment, describing 

the samples, and what was done for extraction, library construction, sequencing and analysis.  



Author response: We agree with the reviewer that this would improve the clarity in our 

protocol and we have limited our protocol to sample preparation and running the instrument 

(lines 124-273). We have included details on how our samples were processed in the 

representative results section (lines 335-344). 

 

4. There would desirably be more information about the samples, eg are these xenografts or 

animal models that developed CRC naturally due to hard living from attending too many 

genomics conference sponsor parties?  

Author response:  We have included additional detail highlighting that the tissue we 

used was xenografts (line 326) and also pointed out to the reader that we have found this 

protocol to work similarly across tissue types including human, xenograft for a variety of normal 

tissues and cancer indications (lines 379-381). 

 

5. There should be a better discussion of sequencing analysis metrics in order to be able to 

declare that the process was indeed a success. For a recent example describing performance 

metrics in sequencing output from dissection, see PMID: 33135777.  

Author response:  Thank you for the suggestion. We have included additional summary 

metrics from our sequencing output in lines 348-352 stating that exome coverage was 

approximately 75 million 100bp paired-end reads, yielding an average depth (before removing 

duplicate reads) of 150X per sample with 99.9% reads aligned and a 78% on-target rate. We go 

on to state that RNA sequencing metrics demonstrated just over 55 million reads, a 98% 

alignment rate and a 19.4% duplication rate with 77% of successfully paired reads in order to 

demonstrate both the exome and RNA sequencing quality.  

 

6. I note that the manuscript doesn't go into tumor enrichment, which one might like to see in a 

paper about a specific experiment, but as this is primarily a method paper for the Millisect that is 

OK. But as such a paper, it would be desirable to have results for the recovery of nucleic acids 

per unit volume (eg ng/mm3) of sample dissected and other performance metrics like how long 

it typically took for a dissection. 

Author response:  We thank the reviewer for this suggestion and have modified our 

table to include the nucleic acid metrics in a per unit volume of sample dissected format 

(Supplementary Table 2). 

 

Minor Concerns: 

7. Detailed Points with page and line numbers following taken from the document Reviewer 

PDF: Jove62394_reviwer.pdf 

Title page Line 9: I think there's an "and" in there that shouldn't be. (Eg The same authors aren't 

both at Roche and Genetech!) 

Author response:  Thank you for noticing this. We have removed the “and” from line 10 

and denoted “Genetech” on line 9 to clarify.  

 



8. Line 64. The question of what is the limit of tumour content for NGS varies by assay. 10% 

would be for a targeted panel assay but is much to low for WGH or Exome. You have 

references for this so it's OK, but you might say that limits vary and then give examples. The 

MSKCC Impact Study as some published limits as does the PMID mentioned above. I don't 

want to get too picky here as everyone really does recognize that more tumor content is better! 

Author response: We agree with the reviewer that more tumor content is better and have 

added a sentence to highlight variability across platforms on lines 70-71 which reads “however, 

limits will vary depending on the platforms utilized and planned use of the data generated.” 

 

9. Line 80. It's true LCM is costly but we're talking about subsequent NGS on million dollar 

machines so that's not really a reason, especially since these processes still need an Aperio or 

similar to scan the slide. 

Author response: We agree that the overall assay cost is still very significant whether the 

user chooses LCM or automated dissection, but automated dissection offers significant savings 

when the laboratory expertise and technical time required to utilize LCM is compared to that of 

automated dissection which is highlighted in lines 85-89.  

  

10. Line 82: Take out "mid range" here, since the rest of the sentence describes nicely how and 

why it is actually mid range. 

Author response: Thank you for this suggestion. “Mid-range” has been removed from 

line 87.  

 

11. Line 84: "cons" is colloquial. Should be "disadvantages" 

Author response: We would like to thank the reviewer for this suggestion and have 

changed “cons” to “disadvantages on line 92. 

 

12. Line 86: "overlay" should be "overlays" unless this is meant to mean something different. 

Author response: Thank you for noticing this typographical error. We have changed 

“overlay” to “overlays” on line 93. 

 

13. Line 89: I would tend to use "regions of interest" rather than tumour as you're going to get a 

lot of normal, and you might not be targeting tumour. 

Author response: We thank the reviewer for the suggestion and agree that this phrasing 

better conveys the options that automated dissection provides. We have therefore changed 

“tumor” to “regions of interest” on line 96.  

 

14. Line 90-100: You could more explicitly state that conventional LCM has ~10um precision, so 

capable of single cell resolution, whereas manual macrodissection is more like 1mm so the 

millisect instrument is in between. 

Author response: We agree that these details would provide further clarity and we have 

modified lines 87-89 to add these details. 

 

15. Line 216: Section 2.6: The instructions for buffer choice is ill-worded. Say, "for FFPE use: 

XXX. For fresh frozen use YYYY" not in parentheses. 



Author response: Thank you for the suggestion. We have reworded this to highlight that 

the user should choose a dissection buffer of their choice that is appropriate for their tissue type 

(FFPE or fresh frozen) and their downstream nucleic acid extraction kit of choice (lines 240-

241). 

 

16. Line: 227. I was confused initially why we are staining at this point and had to read through 

to see we are post-staining for QC in Step2. I would state this more explicitly. 

Author response: We now see that this could be confusing and we have clarified more 

explicitly the rationale for staining at this point in lines 270-273. 

 

17. Line 242 Section 3.3: "minimal mineral oil" should be more like "the minimum oil required to 

resuspend all the fragments or something. 

Author response: Thank you for the suggestion. We have clarified this in lines 337-338 

by rephrasing to “FFPE samples were collected using molecular grade mineral oil and dissected 

samples were pooled together and centrifuged at 25,000 x g for 20 min at 4 oC”. 

  

18. Line Section 3.4. See comments above about this not being specific to the millisect method. 

Author response: We clarified that the user can utilize any commercial kits for extraction 

in lines 274-274 and separated out how our samples were processed in the representative 

results section (lines 335-344) as noted in response 1 above. 

 

19. Line 268: The note about sequencing coverage should be in a Results section for this 

experiment and along with the sample yields in nanograms per mm^3 or similar. 

Author response: Thank you for this suggestion. We have moved this to the results and 

included additional sequencing QC metrics in 348-342. This now reads: “Exome sequencing 

generated approximately 75 million 100bp paired-end reads, yielding an average depth of 

coverage (before removing duplicate reads) of 150X per sample, with 99.9% reads aligned and a 

78% on-target rate. RNA sequencing metrics demonstrated just over 55 million X bp paired-end 

reads, a 98% alignment rate and a 19.4% duplication rate with 77% concordant reads.” 

Additionally, we have included yields in ng/mm^3 in supplementary table 2.  

 

20. Line 272 Representative results. Should be in materials and methods for this experiment. 

Need details or animal model and tumour (Xenograft vs naturally arising) From the pictures they 

look like Xenos. 

Author response: We have added that the tissue used was from xenografts in line 326 

and additionally have included comments that we have seen similar results with other tissue 

types including human tissues from a variety of indications in lines 379-381.  

 

21. Line 284: How do we know that it's successful whole exome sequencing? What metrics are 

used here? 

Author response: Thank you for pointing out that we should show our metrics rather than 

stating “data not shown”. We have provided details of both exome and RNA sequencing metrics 



in lines 348-342 as noted above in response 19 to demonstrate successful sequencing in our 

samples.  

 

22. Line 328- "we have pushed the boundaries of the Millisect system beyond the intended use 

and our protocol is meant for research use only". This is an odd statement. What it its intended 

use other than dissection? 

Author response: We apologize for the confusion here. The Millisect instrument has 

been released for use on clinical FFPE specimens up to 10 µm thick, but is not actively 

marketed for research purposes, for use on thicker sections or for use on fresh frozen tissue. 

However, we saw benefit for use of the instrument for research purposes on both FFPE and 

fresh frozen tissues from various sources including murine and human tissues. We have 

expanded our thoughts and clarified this in lines 107-110.  

 

Reviewer #2: 

1. To Authors, 

This work describes an automation method based on the Avenio milisect commercial solution 

marketed by Roche. Further information and clarification are needed to facilitate understanding 

of this work. Indeed, more precision are necessary in the introduction to precise the context of 

automation for tissue dissection (state of the art) 

Author response: We’d like to thank reviewer number 2 for this suggestion and agree 

that more information on the precision would provide further clarity on the abilities of the 

automated dissection instrument. We have therefore modified lines 87-89 to specify the levels of 

precision of LCM (10 µm) and macrodissection (1 mm) and also included a reference that 

directly compares macrodissection to automated dissection.  

 

2. and the discussion need to be developed to bring information about the relevance of this 

approach with more precision about potential application in research. 

Author response: Thank you to the reviewer for the suggestion to include more clear 

relevance of this approach in research. We now realize from reviewer responses that we 

needed to provide additional clarity on how this technique could be applied to various tissue 

types applicable to a research setting. We have expanded this information in lines 379-385 

where we describe how the technique could be applicable to, and how we have had similar 

results on, many FFPE tissue types inclusive of xenografts and human tissues over a variety of 

indications applicable to the research setting. 

 

3. Introduction: 

The authors must specify and explain this tissue limitation, concrete examples of several 

cancers would be useful to better understand the scope of this work. Also, for the different 

alternative methods, additional information is necessary such as the type of tumours for which 

these methods are or are not used in clinical routine. What exactly is the clinical reality. 

Author response: We appreciate the feedback and have incorporated information to 

highlight that various tissue types ranging from human to xenografts can be used (see response 

to question 2 above) in our protocol. We have also included additional information in the 

introduction on lines 107-110 to clarify that the instrument is marketed and intended for clinical 



use on any human FFPE cancer tissues, but that we have developed a protocol for use in 

research settings applicable to a wider range of tissue types inclusive of FFPE and fresh frozen 

tissue and that this protocol can be expanded beyond human tumors to xenografts or normal 

tissue regions of interest. 

 

4. For the LCM, this methodology is used in which type of cancers. Can this method also be 

automated? It is also important to describe the difference in tissue collection between these 

different methods. 

Author response: All of the techniques mentioned can utilize FFPE material. We 

appreciate the reviewer pointing out that additional clarity was needed here and have added this 

to line 75-76. Specifics on tissue collection for macrodissection can also be found on line 76 and 

those for LCM can be found on 83-84 with references. Similar to our protocol, LCM can be 

applied to any tumor type, but is more technically challenging and requires extensive hands on 

time rather than being an automated process requiring less technical expertise (lines 85-86). 

We felt that a more extensive discussion of whether LCM could be automated to be beyond the 

scope of this more protocol focused manuscript. 

 

5. They recommend this automated method for micro-tumours of less than 250 µm², but in the 

protocol they make 3 or 4 cuts at 20 µm thick and cut on non-stained sections: Is it not too thick 

in relation to the size of the tumour? 

Author response: We apologize for the confusion here. We have modified our wording in 

lines 47 and 48 to clarify that the 250 µm² measurement represents the blade diameter on the 

automated-dissection instrument and the instrument can be used on tumor diameters both 

above and below 250 µm². The author makes an excellent point in that 20 µm² cuts are thick 

and when cutting through very small tumors and regions of interest depletion can be a concern. 

However, our goal was to show the full range of dissection options using the instrument and not 

to validate different tumor sizes or the impact of various section thicknesses on enrichment as 

this is something that would have to be adjusted based on the needs of individual experiments 

We have now included a sentence on lines 101-104 to clarify this point. 

 

6. what is the size limit possible with this method? and what is the lateral resolution of this 

cutting method?  

  Author response: We have delineated the blade sizes on line 99 and note that 

investigation into the lateral resolution is beyond the scope of our protocol focused manuscript. 

Recently, since submission of this manuscript to JoVE, we have released a separate paper 

taking a deeper dive into the resolution of this automated dissection instrument and if it is of 

interest the reviewer can find it under PMID 33497835. We have also now referenced this 

recent publication in line 92.  

 

7. What precautions must be taken to avoid contamination with healthy tissue? 

Author response: We appreciate the concern for healthy tissue contamination and several 

approaches exist to limit the impact of healthy tissue in downstream assays including utilizing 

normal tissue or blood sequencing as a comparator. However, we felt that this was beyond the 

scope of our protocol focused manuscript which is targeted toward region of interest enrichment 



rather than isolation. As we describe in lines 81-84 LCM would be a better choice if region of 

interest isolation down to a single cell level is required.  

 

8. How do they make sure that the micro-tumour is present on all the sections since they only 

stain them after the microdissection? 

Author response: See the response to the first major point of reviewer 2 above and the 

sentence we have now included on lines 101-104 to describe methods of confirmation. 

 

9. if possible in addition to the data, indicate how to make an annotation on imageJ and transfer 

it to the device software. 

Author response: We would like to thank the reviewer for his or her interest. Given the 

need to limit commercial language and feedback from other reviewers that we should focus our 

protocol on our process, we have removed the specific software recommendations and 

generalized the digital mask creation. We have provided details on our protocol surrounding 

specifics for our process, but transfers to the device from all platforms is something that is 

beyond the scope of our protocol and the would need to work with the vendor to establish a 

process based on individual software availability and needs. A sentence stating this has been 

added to line 171-172. 

 

10. Is the NGS the only application possible with this methodology? 

Author response: We appreciate the reviewer pointing out that this remained unclear 

from our text. NGS is not the only application possible and we have added clarity with PCR as a 

specific additional example application that could be possible in line 406. 

 

11. In order to determine the relevance of this method, the results of the NSW analyses should 

be compared between an LCM macrodissection approach and the one described in this 

manuscript, in terms of quality and speed. 

Author response: We thank the reviewer for his or her thoughtful comments. We have 

noted that for equivalent slides in our hands LCM takes twice as long as the automated 

dissection instrument we used in this protocol. However, we did not include these specifics 

because a head to head comparison of the metrics between LCM, macrodissection and 

automated dissection is beyond the scope of our protocol. We have therefore kept our language 

general in lines 87-89 noting that the automated dissection instrument we used falls in between 

that of LCM and macrodissection in terms of numerous metrics. We have also referenced our 

recently published manuscript that does a head to head comparison of macrodissection and 

automated dissection, but additional studies specifically designed to compare LCM and 

automated dissection would need to be done in a separate manuscript to address the 

comparative metrics.   

 

12. Discussion : 

According to the authors, what is the relevance and perspective of this work for a basic , 

translational research and clinical application? 

Author response: Thank you for the opportunity to further clarify the relevance and 

applications of this work. We have modified lines 403-411 to state that we have expanded the 



intended use of the automated dissection instrument from human FFPE to xenografts and 

human FFPE as well as fresh frozen tissues. We then go on to state that we have provided 

protocols for these tissue types that can be used for region of interest enrichment prior to WES 

or RNA sequencing in basic and translational research settings and that other molecular 

applications, including PCR, could also be possible. Finally we describe how these protocols 

could expand the region of interest enrichment options available and could be developed and 

validated further for use in clinical settings. 



Supplementary File 1: Millisect Pseudocode 
 
 
function Millisect_save_pseudo(slidepath) 
%MILLISECT_SAVE_PSEUDO attempts to crop whitespace around tissue, creating 
%one single PNG export with an mask of all ROIs present on a 
%slide.  This function calls several custom APIs in order to access image 
%data and ROI coordinates.  An end user will need to customize this access 
%for their particular system. 
 
%% create mask of ROIS and keep them 
 
% Queries external viewer where ROIs are created.  IF there are no ROIs 
% present on a slide, skip making an overlay image 
AllRegions = VectorAPI(slidepath, 'GETALL'); %get all ROI ID's to be stamped 
 
% if no ROIs, then skip the rest 
if size(AllRegions, 2) > 0 
     
    % get pixel data at a low mag power, high mag is overkill for image alignment 
    imgin = CaptureAPI(slidepath,magpower);     
     
    %% crop whitespace to focus on just regions with tissue 
    % this step is optional, but can help the downstream alignment of the image 
    % on the Millisect 
     
    %create binary mask using global intensity threshold to roughly id tissue 
    tmask = ~imbinarize(rgb2gray(imgin), intensity_thresh) ; 
     
    % use alternating morphological operations of increasing size to remove 
    % small isolated noise and non-tissue 
    tmask = imclose(tmask, d3); 
    tmask = imopen(tmask, d3); 
    tmask = imclose(tmask, d5); 
     
    tmask = ~(bwareaopen(~tmask, 1000)); % closes small holes in tissue 
    tmask = imopen(imclose(tmask, d14), d9); 
    tmask = bwareaopen(tmask, 3000); % removes small pieces of tissue 
    tmask = imopen(tmask, d14); 
    tmask = imclose(tmask, d30); 
    tmask = bwareaopen(tmask, 10000); % removes small pieces of tissue 
    tmask = ~bwareaopen(~tmask, 10000); % closes large holes 
     
    %find convex hull to make one object, dilate to add a little around edges 

Supplemental File (Figures, Permissions, etc.) Click here to access/download;Supplemental File (Figures,
Permissions, etc.);JoVE Supplementary File

https://www.editorialmanager.com/jove/download.aspx?id=1300028&guid=3e3c459d-a9ea-4740-8b59-5cba2d084b77&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=1300028&guid=3e3c459d-a9ea-4740-8b59-5cba2d084b77&scheme=1


    ss_mask = bwconvhull(tmask); 
    ss_mask = imdilate(ss_mask, d14); 
    % get x-y coordinates of bounding box to crop tissue 
    hstats = regionprops(ss_mask, 'BoundingBox') ; 
     
    %% get ROIs 
     
    % query an external viewing platform to return an array of vectors 
    % containing x-y coordinates for ROIs made on a slide, and return a binary 
    % mask of the union of them all at the same size as the raw image 
    add_rois = gSlide_API_ROIs_to_mask(slidepath ,lowmagpower ); 
     
    %crop raw image and binary mask 
    imgin = imcrop(imgin , hstats.BoundingBox) ; 
    add_rois = imcrop(add_rois , hstats.BoundingBox); 
     
    %% process low-res image to make it a manageable size 
     
    dimy = size(imgin, 1); 
    dimx = size(imgin, 2); 
     
    %if longest dimension is greater than 1000 pixels, resize image so longest side is 
    %less than 1000 
    if ( dimy > 1000 || dimx > 1000 ) 
        %find longest side 
        if dimy > dimx 
            resize_factor = 1 / (dimy / 1000) ; 
        else 
            resize_factor = 1 / (dimx / 1000) ; 
        end 
        imgin = imresize(imgin, resize_factor); 
        add_rois = imresize(add_rois, [size(imgin,1) size(imgin, 2)], 'nearest'); 
    end 
     
     
    %% create overlays and save 
     
    % create filename with .jpg extension 
    [~, savename] = fileparts(slidepath); 
    savename = fullfile(savename, '.jpg'); 
     
    %create image overlay of input image with solid green wherever add_rois 
    %binary mask is present 
    im2 = imoverlay(imgin, add_rois, [1 1 0 ]) ; 



    imwrite(im2, savename, 'jpg'); 
     
end 
end 
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Supplementary Table 1.  
 

Case 
Identifier 

% Tumor Area 
per Total 

Tissue Area 

 

Case  
Type 

Harvested 
Area (mm2) 

RNA 

(ng/mm3) 

DNA 

(ng/mm3) 

12547 20 FFPE 612 6.05 8.5 

13072 15 FFPE 101 0.2 13.9 

14124 5 FFPE 29 11.03 19.0 

17321 15 FF 97 3.71 5.4 

16327 10 FF 73 3.9 6.0 
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